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A.  Test Verification 

Test Information 

Test Input  • Selection of ILM GUIs and commands from monitor displays 
• Sample set of ILM files and records 
• Scripts transferring ILM data between the EDF and a simulated DAAC 

Test Output • Display of GUIs with ILM data, reports, and transfer of test data. 

Data Set Name Path Name Description 
ILM data will be 
imported from the 
current and 
development ILM 
systems as required. 

Local ILM Remedy database ILM Entitlement records 
ILM License records 
ILM Hardware records 
ILM supporting records (status codes, hardware software code, inventory location, vendor, maint. 
contracts) 
 

Test Configuration • Two test sites: a simulated DAAC (called DAAC1/GSFC in this procedure) and one EDF site have been configured to emulate the ILM system.  Each 
site has a server with Remedy COTS installed and a PC with Remedy Client software. 

• Each of the test sites has an operational printer. 
• Simulated DAAC Firewall rules allow the transfer of data files between the test sites. 
• ILM administrators for each test site are assigned to ILM groups who have access permissions to read, write and execute on the ILM data. 
• Import/Export file scripts are installed to create the export tar files and transfer the files to receiving sites. 
• An Import directory is created at each test site and is available to receive and store the received tar files 
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Step-By-Step Procedures 
Step # Input Action Expected Results (P)ass/(F)ail/Comments 

 Pre-Test Setup and Check   
10 Remedy is launched and is connecting with the AR system 

database at the DAAC1 and EDF platforms. 
Remedy ARS application is displayed and connects with the 
local Remedy database. 

P 

20 At each Remedy workstation, print to a local printer. Print jobs are printed. P 
30 Remedy system administrator has set export and import utilities at 

EDF andGSFC (DAAC1).  
 
The export and import utilities at the EDF and simulated 
DAAC have been set. 

P 

40 Start Remedy User on the PCs  
1. Click Start/Programs/Action Request System/Remedy User 
2. Enter Remedy username and password 

 
 
Remedy User window is displayed on the PCs. 

P 
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EDF  

Section 1:  ILM License Management 

 20a. Demonstrate that, at the EDF: New products may be defined and 
license information associated with them.  Information about new 
products and associated licenses should be representative of the 
information maintained using the existing (XRP-based) LM capability. 

 

20c.  License information may be updated to indicate new 
license provisions (e.g., seats allowed, floating licenses, etc.) 

 

20b.  Product licenses may be allocated to specific hosts. 

 

140. On the EDF ILM system, enter information for a new 
license and attempt to associate it with a license 
entitlement whose “rights to use” are already fully 
allocated. 

 

150. On the EDF ILM system, enter information for a new 
license and attempt to enter an Entitlement ID where 
the ID does not exist in the database. 

 

20f.  The system tracks licenses remaining, computed as the 
difference between a license entitlement and the licenses 
allocated against it. 
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100 On EDF ILM PC, log in as an ILM license user, “ilmlicense,” and navigate 
to the ILM-License Entitlement Form. 

Click Start -> Programs -> Action Request System -> Remedy User 

Type in “ilmlicense” as User Name and click on OK button. 

Click on File -> Open 

Select “ILM-License Entitlement” form and click the “New” button. 

Login-Remedy User window is displayed. 

Remedy User window is displayed. 

The ILM-License Entitlement form is displayed. 

P 

110 Enter the following information: 

♦ Entitlement Part No: AUTO-EXP<TAB> 

♦ Node Total: 20<TAB> 

♦ Node Under Maint: 20<TAB> 

♦ Vendor ID: PLT<TAB> {on Purchasing_Maint Info tab page} 

♦ PO Number: CCW0002190<TAB> 

♦ Receive Date: 10/30/03<TAB> 

♦ Maint Contract ID:  CCL13766<TAB> 

♦ Press the “Save” icon on the tool bar. 

Record Entitlement ID number                                       You can get the 
Entitlement ID in the status bar at the bottom left of the form.  This number 
will be used later. 

♦ When the Entitlement Part No is entered, the system 
will populate the following fields: MFR, description, 
ECS Alias, License Type, and Version (version may 
or may not available). 

♦ When Maint Contract ID is entered, the Maint Exp 
Date will be populated. 

♦ The system generates the next prefixed “LE” number.  
This number will be displayed on the status bar on the 
bottom left of the form. 

 

P 

120 While you are on the ILM-License Entitlement form, press the Add new 
License button to add new licenses. 

The ILM-License form is displayed.  
P 

130 Enter the following information: 

♦ Entitlement Part No: AUTO-EXP<TAB> 

♦ Receive Date: 10/30/03<TAB> 

♦ When the Entitlement Part No is entered, the system 
will populate the following fields: MFR, description, 
ECS Alias, and License Type. 

♦ The system will generate the next prefixed “L” 

P 
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♦ Platforms: SUN<TAB> 

♦ Serial No: 645316542<TAB> 

♦ Features: P<TAB> 

♦ License Manager: Proprietary<TAB> 

♦ License Key: ECONDSAOTH<TAB> {On License Key Information 
tab} 

♦ Host Name: p0sps06<TAB> 

♦ Host ID: 808041c1<TAB> 

♦ Site: PVC<TAB> 

♦ Key Exp Date: 12/31/04<TAB> 

♦ Press the “Save” button. 

Record License ID number                                       The new License ID is 
briefly displayed on the status bar at the bottom left of the form and on the 
License Entitlement Mapping form.  This number will be used later. 

number. 

♦ License Entitlement Mapping form is displayed 

♦ The system will also populate the following fields 
deriving from license information just entered: 
License ID, ECS Alias, License Type, and MFR. 

 

 

 

 
 
 
 
 
 
 

140 Enter the following information on the ILM-License Mapping form to map 
the entered license to a entitlement. 

♦ Entitlement ID:  LE000602<TAB> 

♦ Node RTU Allocated: 1<TAB> 

♦ Select OK on Error window 

♦ A message is displayed ”Node allocated is greater 
than Node remaining. Reduce number of Right-to-Use 
or enter another Entitlement ID”. 

♦ The association is rejected. 

P 

150 Enter the following information to map the entered license to an entitlement. 

♦ Entitlement ID:  LE00003<TAB> 

♦ Select OK on Error window 

♦ A message is displayed stating that the Entitlement ID 
[Entitlement ID] does not exist. 

♦ The system rejects the Entitlement ID. 

P 

160 Enter the following information on the ILM-License Mapping form to map  P 
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the entered license to an entitlement. 

♦ Entitlement ID: <Entitlement ID created in step 110><TAB> 

♦ Node RTU Allocated: 1<TAB> 

♦ Press the “Save” button. 

♦ Close the form. 

 

♦ When the Entitlement ID is entered, the system will 
populate the Node RTU Remain field. 

♦ Record is saved. 

♦ Form is closed. 

170 Navigate to the ILM-License Entitlement form to confirm that the Node 
Allocated and Node Remaining is incremented and decremented 
accordingly: 

♦ Click on Window 

♦ Select the “ILM-License Entitlement Search form. 

The ILM-License Entitlement form re-appears. P 

180 Perform the search for Entitlement ID “<Entitlement ID created in step 
110>” and verify that the node RTU Allocated is now 1, and Node 
Remaining is now 19. 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter “<Entitlement ID created in step 110>” into the Entitlement ID 
field 

♦ Click on “Search” 

♦ Verify the information.  

♦ Close the form. 

♦ The Entitlement ID “<Entitlement ID created in step 
110>” is displayed. 

♦ Node Allocated is 1. Node Remaining is 19. 

 

P 

 20d.  Product licenses may be de-allocated from hosts.   

200 While the ILM-License form is opened,  

♦ Click on the “New Search” icon on the tool bar. 

♦ Enter License ID “<License ID created in step 130>” into the License 
ID field 

The system will display the license information for 
License ID “<License ID created in step 130>” 

P 
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♦ Click on the “Search” icon again to perform the search. 

210 Blank out the following fields for License ID “<License ID created in step 
130>” to remove the host information: 

♦ Host Name: <BLANK> {License Key Information tab} 

♦ Host ID: <BLANK> 

♦ Site: <BLANK> 

♦ Press the “Save” icon on the tool bar. 

♦ Close the form. 

♦ Specified fields are now blank. 

♦ Form is closed 

 

P 
 
 
 
 

 20e.  Product definitions and associated license may be removed from 
the LM capability. 

NCR- ESCed39128 – Remedy ILM Data Records’ deletion 
activity is incomplete. 

  

300 Open the ILM-License Entitlement form in Search mode.  

♦ Enter Entitlement ID “Entitlement ID created in step 110” into the 
Entitlement ID field 

♦ Click on the “Search” icon to perform the search. 

♦ Enter “Y” in the Delete Entry field {On Purchasing_Maint Info tab}. 

♦ Click the “Save” icon on the tool bar 

♦ A message displayed stating “Sorry, can not delete 
this Entitlement ID $Entitlement ID$.  This 
Entitlement ID is being used in the ILM-License 
Mapping form.  Please remove the mapping first 
before deleting this record.” 

♦ The Delete Entry field is blank out. 

 

P 
 
 
 
 
 
 

310 While the ILM-License Entitlement form is opened,  

♦ Click on the “New Search” icon on the tool bar. 

♦ Enter Entitlement ID “LICENTODEL” into the Entitlement ID field 

♦ Click on the “Search” icon to perform the search. 

♦ Enter “Y” in the Delete Entry field. 

♦ Entitlement ID “LICENTODEL” is marked to be 
deleted. 

P 
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♦ Click the “Save” icon on the tool bar 

320 While the ILM-License form is opened,  

♦ Click on the “New Search” icon on the tool bar. 

♦ Enter License ID “LICTODEL” into the License ID field 

♦ Click on the “Search” icon to perform the search. 

♦ Enter “Y” in the Delete Entry field.  {On License Key Information tab} 

♦ Click the “Save” icon on the tool bar. 

♦ Click “Yes” 

♦ A message displayed stating “Deleting License ID 
“LICTODEL” will also delete any license mapping 
and any additional host related to this License ID.  
Are you sure you want to delete this License ID?” 

♦ License ID “LICTODEL” is marked to be deleted. 

P 

330 Verify that all License mapping having License ID LICTODEL are marked 
to be deleted. 

 

� Click on “Open” 

� Select “ILM-License Mapping” form 

� Select “Search” 

� Enter “LICTODEL” into the License ID field. 

� Confirm that there is a Y in the Delete Entry field. 

♦ License mapping having License ID ‘LICTODEL” 
have a Y in the Delete Entry field. 

P 

340 Verify that all Additional Hosts having License ID LICTODEL marked to 
be deleted. 

� Click on “Open” 

� Select “ILM-Additional Host” form 

� Select “Search” 

� Enter “LICTODEL” into the License ID field. 

♦ Additional Host having License ID ‘LICTODEL” 
have a Y in the Delete Entry field. 

P 
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� Confirm that there is a Y in the Delete Entry field. 

 20g.  Reports may be generated showing the products licensed to a 
particular host. 

 

20h.  Reports may be generated showing hosts associated with a 
particular license. 

  

400 Log in again as an ILM license user, “ilmlicense.” Navigate to the ILM-
LICENSE form and click the Search button. With the ILM-License form on 
display, perform the following actions to generate the “License Allocation 
by Host Report” for host p0sps06. 

♦ Click on Reports on the menu bar 

♦ Select the “License Allocation by Host Report” 

♦ Enter “p0sps06” as the host name. 

♦ Click the Run Report button. 

♦ Click the Report Preview icon at the bottom of the screen. 

♦ Close the Report window. 

♦ When the “License Allocation by Host Report” is 
selected, the system prompts the user to enter a host 
name. After a host name is entered and the Run 
Report button is clicked, the system generates the 
License Allocation by Host Report for the host 
entered and places a Report Preview icon for the 
report at the bottom of the screen. 

 

♦ Report is displayed. 

♦ Report is removed. 

 

P 
 
 
 
 
 
 
 
 

 20i.  Report may be generated showing license information for a 
particular product. 

  

500 While the ILM-License form is on display, perform the following actions to 
generate the “License Allocation by Product Report” for Clearcase. 

♦ Click on Reports on the menu bar 

♦ Select the “License Allocation by Product Report” 

♦ Enter “CLEARCASE” in the ECS Alias field. 

♦ Click the Run Report button 

♦ When the “License Allocation by Product Report” is 
selected, the system prompts the user to enter an ECS 
Alias. 

♦ After an ECS Alias is entered and the Run Report 
button is clicked, the system generates the “License 
by Product Report” for the product entered and places 
an icon for the report at the bottom of the screen. 

P 
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♦ Click the Report Preview icon at the bottom of the screen 

♦ Close the report window. 

♦ Report is displayed. 

♦ Report is removed. 

510 ♦ Click on Close Report button. 

♦ Close the ILM-License form. 

♦ Report is removed. 

The Form is closed. 

P 

 170.  On the EDF ILM system as an operator authorized access to 
update license management data only, attempt to modify EIN records.   

  

600 Re-login or verify login to Remedy as a License User: “ilmlicense”. 

♦ Click on Tool on the menu bar 

♦ Click logon 

♦ Enter username and password 

♦ Click OK 

Remedy window is displayed. P 
 

610 Navigate to the ILM-EIN form. 

♦ Click on the “Open” icon on the tool bar 

♦ Select “ILM-EIN” form 

♦ Select “Search” 

The ILM-EIN form is displayed P 

620 Attempt to modify an ILM-EIN form record. 

♦ Click on the “Search” icon on the tool bar 

♦ Enter “TESTING” in the ECS Name field 

♦ Press the “Save” button 

♦ Click OK on the Remedy User Error message 

♦ Close the form 

♦ Click Yes on the Remedy User window to close the form. 

♦ EIN records are listed in the index and the content of 
the first record is displayed. 

♦ TESTING is displayed in the ECS Name field. 

♦ An error message is displayed stating that the user 
does not have write access to the field. 

♦  A Remedy User message is displayed indicating that 
the change has not been saved.  

♦ Form is closed.  

P 
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Section 2: ILM Inventory Management  

 30f.  The operator may define new resources.   

 

50a.  Add a new item to the inventory. 

 

90a+b. Enter a new inventory item’s data into the displayed fields and 
enter an existing EIN number into the EIN field. 

 

 100a+b. Enter as the item’s part number a value for an OEM Part that does 
not exist in the database. 

 

110a+b. Enter information for a new inventory item.  However, do not 
complete one of the required fields. 

  

700 Log in as an ILM property user, “ilmpropty,” and navigate to the ILM-EIN 
form to add new inventory/resources to the database. 

♦ Click the “Open” icon on the tool bar 

♦ Select the “ILM-EIN” form 

♦ Select “New” 

The system displays the ILM-EIN form. P 

710 Enter the following information: 

♦ EIN:  00001881<TAB> 

♦ Press “OK” 

♦ When the user enter EIN (00001881), a message is 
displayed stating that the EIN already exists, and the 
system rejects the EIN. 

♦ When the user enter Part No (A30-XXX-4SFV880), a 

P 
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♦ EIN:  00020299<TAB> 

♦ ECS Name: f0dps01<TAB> 

♦ Serial No: 237V00C9<TAB> 

♦ Part No:  A30-XXX-4SFV880<TAB> 

♦ A message is displayed, press “OK” 

♦ Clear the Part No above 

♦ Part No: A30-WSF-4SFV880<TAB> 

♦ Location: EDF<TAB> 

♦ Room:  1073<TAB> 

♦ PO Number: CCJ0014135<TAB> 

♦ Cost: 57996<TAB> 

♦ Receive Date: 10/30/03 <TAB> 

♦ Click on the “Save” icon on the tool bar. 

♦ Press “OK” when a message is displayed. 

♦ Vendor ID:  SUN<TAB> 

♦ Click on the “Save” icon on the tool bar. 

message is displayed stating that the Part No (A30-
XXX-4SFV880) does not exist and asks the user to 
enter another part or add the new part into the ILM-
OEM Parts table. 

♦ When Part No (A30-WSF-4SFV880) is entered, the 
system populates the following fields: Description, 
MFR, Hw-Sw Code, and Mod-Ver. 

♦ When location is entered, the system populates the 
building field. 

 

♦ When receive date is entered, the system will set the 
audit date to the receive date and the warranty exp 
date to 1 year after the receive date. 

♦ When the user presses the “Save” icon without 
entering the Vendor ID (one of the required fields), 
the system will display a message stating that one of 
the required fields is not completed. 

♦ Pressing the “Save” icon again saves the data and 
clears the form. 

♦ A “Submit Successful” message is displayed. 

 NCR - ECSed39223 – Incorrect ILM Part number related fields’ data import   

715 With the form up: 

♦ Select New Search icon 

♦ Enter EIN:  00020299<TAB> 

♦ Select Search button 

♦ Click on the Part No field and <TAB> to the next field. 

 

 

The system displays the ILM-EIN form. 

� The description is unchanged. 

♦ The system sets the Exp field to “Y”. 

P 
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♦ Scroll to the Exp field at the bottom of the form. 

♦ Select the Maintenance and Other Info Tab and inspect the NASA 
Contract ID field. 

♦ The NASA Contract ID is set as NAS5-03098. 

 30m.  Verify by comparison with the contents of the parts table that the 
system populates certain attributes when the operator selects an item 
from a list of parts.  The attributes to be populated are expected to 
include description, manufacturer, model/version, and hardware-
software code. 

  

800 Navigate to the ILM-OEM Parts Form to compare Part No (A30-WSF-
FSFV880) entered above in the ILM-EIN form vs. the ILM-OEM Parts 
form. 

♦ On the ILM-EIN form, press on the “Add New Part” button 

♦ Enter “A30-WSF-4SFV880” into the Part No field 

♦ Click on the “Search” icon on the tool bar. 

♦ Compare the  

Description – SUN V880 W/8GB MEM 4 900MHZ 6X73GB HD 

MFR - SUN  

Hw-Sw Code - H 

Mod-Ver  V880 
on the ILM-OEM Parts form vs. the ILM-EIN form.  The data 
should be identical. 

The system displays the ILM-OEM Parts form when the 
user clicks on the “Add New Part” button on the ILM-EIN 
form. 
 
 
 
 
 
 
 
 

♦ The ILM-EIN form’s part data is identical to the ILM-
OEM Parts form’s data. 

 

 

 

P 

 NCR – ECSed39128 – Remedy ILM Data Records’ deletion activity   

810 While the ILM-OEM Parts from is displayed with Part No “A30-WSF-
4SFV880” 

� Entry a “Y” in the Delete Entry field. 

A message displayed stating “Can not delete Part No A30-
WSF-4SFV880.  This Part No is being used in the ILM-
EIN form.” 

The Delete Entry field is blank out. 

P 
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� Click the “Save” button. 

 

 30l.  Verify that when a new inventory item is added, an EIN will be 
automatically provided if the operator does not input one.  To be 
performed at the EDF. 

 

30h.  The operator may, when defining a resource, distinguish between 
ECS resources and non-ECS resources.  To be performed at the EDF. 

  

900 While the ILM-EIN form is on the display, enter the following information 
to add another new item to the database: 

♦ Click on the “New Request” icon on the tool bar 

♦ EIN: <TAB> 

♦ Parent EIN: 00020299<TAB> 

♦ Serial No: 28542159<TAB> 

♦ Part No: 501-2480<TAB> 

♦ Cost: 420 (on Location and Purchasing Info tab)<TAB> 

♦ NASA Contract (Maintenance & Other Info Tab):  NPOSS 

♦ Click on the “Save” icon on the tool bar 

Record the EIN number                             The new EIN number is displayed 
on the status bar at the bottom left of the form.  This number will be used 
later.  

♦ When Parent EIN (00020299) is entered, the system 
populated the ECS Name, Vendor ID, PO number, 
Receive date, Location, Building, and room to that of 
the Parent EIN values. 

♦ When Part No is entered, the system populates the 
following fields: Description, MFR, Hw-Sw Code, 
and Mod-Ver (Mod-Ver may or may not have data). 

♦ When the “Save” icon is pressed, the system performs 
the following functions: 

♦ Generates the Next prefixed “C” number.  The C 
number can be seen on the Status bar. 

 

P 

905 While the ILM-EIN form is on the display, enter the following information 
to redisplay the form 

♦ Click on the “New Search” icon on the tool bar 

 

 

♦ EIN record is displayed 

P 
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♦ Enter <EIN number from step 900>: <TAB> 

♦ Select “Maintenance and Other Info” tab 

♦ Inspect NASA Contract field 

 

♦ NASA Contract field displayed NPOSS as its value. 

 30e.  The operator may update resource data.  To be performed at the 
EDF. 

 

50c.  Update attributes for an item in the inventory. 

  

1000 While the ILM-EIN form is on the display, perform the following updates 
for EIN 00000002: 

o Click on the “New Search” icon on the tool bar. 

o Enter  “00000002” into the EIN field. 

o Click on the “Search” icon on the tool bar. 

o Enter “208986742” into the Serial No field. 

o Press the “Save” icon 

 

 

 

 

♦ The system displays EIN 00000002 record. 

 

 

♦ The system saves the new Serial No into the database. 

 

P 

 30g.  The ILM Administrator may delete a resource.  To be performed 
at the EDF. 

 

50b.  Delete an item from the inventory 

NCR –ECSed39128 – Remedy ILM Data Records’ deletion activity 

  

1100 While the ILM-EIN form is on the display, enter the following information 
to redisplay the form 

♦ Click on the “New Search” icon on the tool bar. 

♦ The system displays EIN 00020299 record. 

♦ A message displayed “Can not delete EIN 00020299”.  
This EIN is a parent.  Please relocate all the 

P 
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♦ Enter EIN “00020299” into the EIN field 

♦ Click on the “Search” icon on the tool bar. 

♦ Enter a “Y” in the Delete Entry field. 

♦ Click the “Save” button. 

components before deleting this EIN.” 

♦ The Delete Entry field is blank out. 

1110 While the ILM-EIN form is on the display, enter the following information 
to redisplay the form 

♦ Click on the “New Search” icon on the tool bar. 

♦ Enter EIN “EINTODEL” into the EIN field 

♦ Click on the “Search” icon on the tool bar. 

♦ Enter a “Y” in the Delete Entry field. 

♦ Click the “Save” button. 

♦ EINTODEL record is displayed. 

♦ A Deletion message is displayed asking for your 
confirmation of the deletion attempt. 

♦ EINTODEL record is marked for deletion. 

P 

1120 Navigate to the ILM-EIN Structure form. 

♦ Click File -> Open -> ILM-EIN Structure -> Search 

♦ Enter EIN “EINTODEL” into the Component EIN field and click the 
Search icon. 

♦ Close the ILM-EIN Structure form. 

♦ EINTODEL record is marked for deletion. 

♦ ILM-EIN Structure form is closed. 

P 

 30a. An operator may view a display of a catalog of resources (e.g., 
hardware items, software items, consumable items) and information 
about those resources.  Information available should be representative 
of the information available in existing (XRP-based) resource catalog 
reports and displays.  To be performed at EDF.  (Note: for a simulated 
DAAC see step 3210 ) 

  

1200 Perform the following to view all the catalog of resources in the database: 

 

 

 

P 
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♦ Click on the “Search” icon on the tool bar twice The system displays an index that lists the maximum 
number of records set for the index. 

 30b.  An operator at the EDF ILM system may select to display a listing 
of the resources for a particular DAAC or a system-wide listing of 
resources.  

  

1300 While the ILM-EIN form is displayed, perform the following to view a 
listing of resources located at GSFC: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter “GSFC” into the Location field 

♦ Click on the “Search” icon on the tool bar 

 

 

 

The system displays all the records in the database where 
the location value is equal to GSFC. 

P 

 30c.  An operator may display a listing of consumable resources, non-
expendable resources, or both. To be performed at the EDF.  (Note: See 
step 3310  for simulated DAAC). 

 

30d.  The operator may display inventory information for each 
individual non-expendable resource defined in his system.  To be 
performed at the EDF. (Note: See step 3330 for simulated DAAC). 

  

1400 While the ILM-EIN form is displayed, perform the following to view a 
listing of Consumable resources: 

♦ Click on the “New Search” icon on the tool bar 

♦ Select “Consumables” from the list of Hw-Sw Code 

♦ Click on the “Search” icon on the tool bar 

 

 

 

The system displays all the consumable items in the 
database. 

P 

1410 While the ILM-EIN form is on the display, perform the following to view a 
listing of Hardware resources: 

♦ Click on the “New Search” icon on the tool bar 

 

 

 

P 
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♦ Select “Hardware” from the list of Hw-Sw Code 

♦ Click on the “Search” icon on the tool bar 

The system displays all the hardware items in the 
database. 

1420 While the ILM-EIN form is displayed, perform the following to view a 
listing of Hardware and consumable resources: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter “[HC]” into the Hw-Sw Code 

♦ Click on the “Search” icon on the tool bar 

 

 

 

The system displays all the hardware and consumable 
items in the database. 

P 

 30j.  An operator at the EDF ILM system may run predefined site and 
system-wide inventory reports for printout or display. 

  

1500 While the ILM-EIN form is displayed, perform the following actions to 
generate an inventory report for EDC: 

♦ Click on “New Search” icon on the tool bar 

♦ Enter “EDC” in the Location 

♦ Click on “ToolsÆReporting… 

♦ Select “Inventory Rpt” from the list of reports 

♦ Click on ‘ReportÆExport to Æ File 

♦ Save as type ‘All  files (*.*)’ is selected 

♦ Save the report as “EDC_Inventory<date>” in c:\program 
Files\Remedy\home\ 

♦ Click OK on the Remedy User window  

♦ Close the Report window. 

 

 

 

 

 

 

 

 

♦ EDC’s inventory report is generated.  

♦ A Remedy User message is displayed indicating the 
format in which the file will be saved. 

 

P 

1520 To view the report in Excel,  

♦ Launch MS Excel  

 

 

P 
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♦ Open the ‘EDC_Inventory’ file in the C:\Program Files\Remedy\Home\ 
directory:  (Select ‘Show All Files” if needed) 

♦ The “Text Import Wizard” appears, ensure that Delimited is selected as 
the file type in the Original Data Type section. 

♦ Press “Next” button on the bottom. Ensure that Tab is selected as the 
Delimiters. Press “Next” button again. 

♦ Set the EIN and Parent EIN columns to Text using the Column data 
forma radio buttons. 

♦ Press Finish button. 

♦ Select File->Print from the Excel menu 

♦ Select the OK button on the Print screen. 

♦ Minimize Excel. 

 

 

 

 

 

 

♦ The EDC’s Inventory report is displayed in Excel. 

 

♦ The EDC’s Inventory report is printed. 

♦ Excel screen is minimized. 

 

1530 While the ILM-EIN form is displayed, perform the following actions to 
generate an inventory report for the system: 

♦ Click on “New Search” icon on the tool bar 

♦ Click on “ToolsÆReporting… 

♦ Select “Inventory Rpt” from the list of reports 

♦ Click on ‘ReportÆExport to Æ File 

♦ Save as type ‘All  files (*.*)’ is selected 

♦ Save the report as “System_Inventory<date>” in c:\program 
Files\Remedy\home\ 

♦ Click OK on the Remedy User window  

♦ Close the Report window. 

 

 

 

 

 

 

 

 

♦ System’s inventory report is generated.  

♦ A Remedy User message is displayed indicating the 
format in which the file will be saved. 

P 
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1520 To view the report in Excel,  

♦ Click on the MS Excel icon 

♦ Open the ‘System_Inventory’ file in the C:\Program 
Files\Remedy\Home\ directory: (Select ‘Show All Files” if needed) 

♦ The “Text Import Wizard” appears, ensure that Delimited is selected as 
the file type in the Original Data Type section. 

♦ Press “Next” button on the bottom. Ensure that Tab is selected as the 
Delimiters. Press “Next” button again. 

♦ Set the EIN and Parent EIN columns to Text. 

♦ Press Finish button. 

♦ Select File->Print from the Excel menu 

♦ Select the OK button on the Print screen. 

♦ Close Excel. 

 

 

 

 

 

 

 

 

♦ The system’s Inventory report is displayed in Excel. 

 

♦ The system’s Inventory report is printed. 

♦ Excel is closed. 

P 

 40c.  The operator may add new items to the inventory, including 
spares.  To be performed at the EDF. 

 

50d.  Add a new spare item to the inventory. 

  

1600 While the ILM-EIN form is displayed, perform the following actions to add 
a new spare item to the database: 

♦ Click on the “New Request” icon on the tool bar 

♦ EIN: <TAB> 

♦ Serial No: 85165321<TAB> 

 

 

 

 

♦ When Part No is entered, the system populates the 
following fields: Description, MFR, Hw-Sw Code, 

P 
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♦ Part No: 501-2480<TAB> 

♦ Location:  GSFC<TAB> 

♦ Room: C101R<TAB> 

♦ Item Status: SP<TAB> 

♦ Vendor ID: SUN<TAB> 

♦ PO Number:  CCW0042581<TAB> 

♦ Cost: 320<TAB> 

♦ Quantity: 1 <TAB> 

♦ Receive Date: 10/30/03<TAB> 

♦ Press the “Save” icon on the tool bar 

Record C number                                       The new EIN number is displayed 
on the status bar at the bottom left of the form.  This number will be used 
later. 

and Mod-Ver (if entered). 

♦ When Location is entered, the system populates the 
building field accordingly. 

 

 

 

 

♦ When the “Save” icon is pressed, the system performs 
the following functions: 

♦ Generates the Next prefixed “C” number.  
The C number can be seen on the Status bar. 

 

 40d.  The operator may update spares data.  To be performed at the 
EDF. 

 

50e.  Update attributes for a spare item in the inventory. 

  

1700 While the ILM-EIN form is displayed, perform the following to assign a 
spare EIN 00001334 to Parent EIN 00020299. 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter EIN 00001334 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Verify the Item Status for EIN 00001334 is SP (Spare) 

 

 

 

 

♦ The system displays EIN 00001334 record. 

♦ Item Status is SP 

P 
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♦ Enter EIN 00020299 into the Parent EIN field 

♦ Press the “Save” icon on the tool bar 

♦ Close the ILM-EIN form. 

♦ The EIN 00020299 is entered into the Parent EIN 
field, the system set the following fields to EIN 
00020299 values: ECS Name, Location, Building, 
and Room. 

♦ The Item Status for EIN 00020159 was changed to I 
for Install 

♦ ILM-EIN form is closed. 

 40b.  An operator at the EDF ILM system may select to display a spare 
inventory listing for a particular DAAC or a listing of spares system-
wide. 

 

40f.  An operator at the EDF ILM system may run predefined site and 
system-wide inventory spares reports for printout or display. 

  

1900 While the ILM-EIN form is displayed, perform the following actions to 
generate an inventory report for NSIDC: 

♦ Click on “ILM Reports” 

♦ Select “Spare Equipment Report” from the list of reports  

♦ Enter NSIDC in the Site field. 

♦ Click Run Report button. 

♦ Click on the “Report Preview” to view the report  

♦ Click on Remedy printer icon and on OK. 

♦ Close the Report Preview window.. 

 

 

♦ A list of reports is displayed. 

♦ ILM-DIA-Reports window is displayed. 

♦ A Report Preview icon is displayed at the bottom of 
the screen. 

♦ The NSIDC’s spare report is displayed. 

 

♦ The report is printed 

♦ The Report Preview window is removed. 

 

P 
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1910 Generate a system-wide inventory report.  

♦ Click on ILM Reports 

♦ Select the Spare Equipment Report 

♦ Click Run Report button. 

♦ Click on the “Report Preview” button to view the report 

♦ Scroll to Location column and note DAACs 

♦ Click Report’s right arrow to display following pages. 

♦ Close the Report Preview window.. 

♦ A list of reports is displayed 

♦ ILM-DIA-Reports window is displayed. 

♦ A Report Preview icon is displayed at the bottom of 
the screen. 

♦ The system-wide report is displayed. 

♦ The Report Preview window is removed. 

 

P 
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Section 3: EIN Inventory Transactions 

 80a.  In a single transaction, an operator may update the inventory to 
reflect that an item and its associated components have been installed at 
a location. 

  

2100 While the ILM-EIN form is displayed, perform the following functions: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter 00020299 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Note the ECS Name __________ and Location _______________ 
values for the EIN and its components 

♦ Click on the “EIN Transaction” button on the bottom of the form 

 

 

 

 

 

 

The system displays the ILM-EIN Transaction form. 

P 

2110 Enter the following information into the ILM-EIN Transaction form to 
install Parent EIN 00020299 and all of its components to a new location: 

♦ Parent EIN: 00020299<TAB> 

♦ Effective Date: <current date><TAB> 

♦ Select “Installation” from the Transaction Type field<TAB> 

♦ New ECS Name: g0dus01<TAB> 

♦ New Location: GSFC<TAB> 

♦ New Room: W030<TAB> 

♦ Click on the “Execute Transaction” button 

♦ Click on the Exit EIN Transaction button. 

♦ When the Parent EIN is entered, the system populates 
the ECS Name, System Serial No, Part No, MFR, 
Description, Location, building, and room. 

♦ When the “Installation” is selected from the 
Transaction Type, the system activates the 
Install/Move/Ship/RTS page. 

♦ The transaction is processed. 

♦ A prompt appears asking if you would like to perform 
another transaction. 

♦ The ILM-EIN Transaction form is removed. 

P 
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2120 Navigate to ILM-EIN form to confirm that EIN 00020299 and its 
components were updated. 

♦ Click on Window on the menu bar 

♦ Select ILM-EIN form 

♦ Select View/Refresh. 

♦ Verify that EIN 00020299 and its components are updated.  

These fields have the following values: 

♦ ECS Name = g0dus01 

♦ Location = GSFC 

♦ Building = 32 

♦ Room = W030 

♦ Item Status = I 

♦ Installation Date = <current date> 

♦ Audit Date = <current date> 

♦ Exp = Y 

P 

2130 Navigate to the ILM-Transaction log to confirm that the system logs the 
installation transaction performed above for EIN 00020299 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-Transaction Log 

♦ Click “Search” 

♦ Enter EIN 00020299 into the EIN field 

♦ Click the “Search” icon on the tool bar 

♦ Verify that the system records the EIN’s from values and to values 
mentioned above. 

♦ Close the ILM-Transaction Log form. 

 

 

 

 

 

♦ The system displays EIN 00020299 record. The 
“From” and “To” values are displayed in the record. 

 

♦ The ILM-Transaction Log form is removed. 

 

P 

 80b.  In a single transaction, an operator may update the inventory to 
reflect that an item and its associated components have been 
transferred to a new location. 
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130.  On the EDF ILM system, attempt an EIN movement (intra-site 
transfer) for an item that is an active component of some parent EIN. 

2200 While the ILM-EIN form is displayed, perform the following functions: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter 00001881 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Note the ECS Name and Location values for the EIN and its 
components 

♦ Click on the “EIN Transaction” button on the bottom of the form 

 

 

 

The system displays the ILM-EIN Transaction form. 

ECS Name ___________ 

Location ___________ 

P 

2210 Enter the following information into the ILM-EIN Transaction form to move 
Parent EIN 00001881 and all of its components to a new location: 

♦ Parent EIN: 00011751<TAB> 

♦ Press “OK” on the message window. 

♦ Parent EIN: 00001881<TAB> 

♦ Effective Date: <current date><TAB> 

♦ Select “Movement” from the Transaction Type field<TAB> 

♦ New ECS Name: ILMSERV<TAB> 

♦ New Room: 2101B<TAB> 

♦ Click on the “Execute Transaction” button 

♦ Click on the “Exit EIN Transaction” button. 

 

 

♦ A message is displayed stating “Parent EIN 
(00011751) does not exist.  Enter the correct Parent 
EIN.” 

♦ When the Parent EIN is entered, the system populates 
the ECS Name, System Serial No, Part No, MFR, 
Description, Location, building, and room. 

♦ When the “Movement” is selected from the 
Transaction Type, the system makes the 
Install/Move/Ship/RTS page visible. 

♦ A prompt appears asking if you would like to perform 
another transaction 

♦ The ILM-EIN Transaction form is removed. 

P 

2220 Navigate to ILM-EIN form to confirm that EIN 00001881 and its 
components were updated. 

The system performed the following updates for the 
Parent EIN and its components when the Execute 
Transaction button was pressed in step # 2210: 

P 
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♦ Click on Window on the menu bar 

♦ Select ILM-EIN form 

♦ For EIN 00001881 form select View/Refresh. 

♦ Verify that EIN 00001881 and its components were updated.  

♦ ECS Name = ILMSERV 

♦ Room = 2101B 

♦ Item Status = I 

♦ Installation Date = <current date> 

♦ Audit Date = <current date> 

♦ Exp = Y 

2230 Navigate to the ILM-Transaction log to confirm that the system logs the 
installation transaction performed above for EIN 00001881 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-Transaction Log 

♦ Click “Search” 

♦ Enter 00001881 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Verify that the system records the EIN’s from values and to values 
mentioned above. 

♦ Close the ILM-Transaction Log form. 

 

 

 

 

♦ The system logged the transaction into the ILM-
Transaction log and the system displays the EIN 
00001881 record. The “From” and “To” values are 
displayed in the record. 

♦ The ILM-Transaction Log form is removed. 

 

P 

 80c. In a single transaction, an operator may update the inventory to reflect 
selected components have been relocated to a different parent item. 

120. On the EDF ILM system, attempt an EIN relocation where the 
New Parent EIN does not exist in the database. 

 

30i. The operator may associate an inventory item with a parent item 
effective for a user specified range of dates.  To be performed at the 
EDF. 
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2300 While the ILM-EIN form is displayed, perform the following functions: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter 00008525 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Note the ECS Name and Location values for component EINs 
00008525. 

ECS Name __________ 

Location ___________ 

♦ Click on the “EIN Transaction” button on the bottom of the form 

 

 

 

♦ The record for EIN, 00008525 is displayed. 

 

 

 

 

♦ The system displays the ILM-EIN Transaction form. 

P 

2310 Enter the following information into the ILM-EIN Transaction form to 
relocate EIN 00008525 to a new Parent EIN 00020299: 

♦ Parent EIN: 00000127<TAB> 

♦ Effective Date: <current date><TAB> 

 

♦ Select “Relocation” from the Transaction Type field<TAB> 

 

 

♦ New Parent EIN: 00050000<TAB> 

♦ Press “OK” on the Warning window. 

♦ New Parent EIN: 00020299<TAB> 

 

♦ Click on the “Select Components to Process” button. 

 

 

♦ When the Parent EIN is entered, the system populates 
the ECS Name, System Serial No, Part No, MFR, 
Description, Location, building, and room. 

♦ When the “Relocation” is selected from the 
Transaction Type, the system activates the Relocation 
page. 

♦ When Parent EIN 00050000 is entered, a message 
displayed stating that Parent EIN 00050000 does not 
exist. 

♦ When Parent EIN 00020299 is entered and TAB is 
pressed, Remedy moves to the Execute Transaction 
button at the bottom of the window. 

♦ When the Select Component to Process button is 
pressed, the ILM-Join-Process Component form is 

P 
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♦ Single click on Component EIN 00008525 

♦ On the ILM-Join-Process Component form, Enter a “Y” into the 
Process  field where the component EIN is 00008525 

♦ Click on the save icon 

♦ Close the ILM-Join-Process Component form 

♦ Click on the “Execute Transaction” button on the ILM-EIN Transaction 
form 

♦ Click “OK” on the Remedy User Note window. 

♦ Click the “Exit EIN transaction” button. 

displayed. 

♦ Component EIN record is saved with a “Y” in the 
Process field. 

♦   ILM-Join-Process Component is removed. 

♦ When Execute Transaction button is clicked, Remedy 
responds with Note, “All components are processed.”  

♦ A prompt appears asking if you would like to perform 
another transaction. 

♦ “Perform Another Transaction” prompt window is 
removed.  

 

2320 Navigate to ILM-EIN form to confirm that EIN 00020299 and component 
EIN 00008525 were updated. 

♦ Click on Window on the menu bar 

♦ Select ILM-EIN form 

♦ If EIN 00020299 is not already displayed, perform a search for that 
EIN. 

♦ Verify that EIN 00008525 has been added to the list of components on 
the 00020299 record’s Components Tab by clicking the Components 
Tab. 

♦ Click the New Search icon, enter 00008524 into the EIN field, and click 
the Search icon. 

 

 

 

 

 

♦ EIN 00020299’s  record is displayed. 

 

 

♦ EIN 00008524 is listed as a component of EIN 
00020299. 

♦ EIN 00008524’s record is displayed. These fields 
have the following values: 

♦ Parent EIN = 00020299 

♦ ECS Name = g0dus01 

P 
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♦ Location = GSFC 

♦ Building = 32 

♦ Room = W030 

♦ Item Status = I 

♦ Installation Date = <current date> 

♦ Audit Date = <current date> 

♦ Exp = Y 

2330 Navigate to the ILM-Transaction log to confirm that the system logs the 
relocation transaction performed above for EIN 00008525 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-Transaction Log 

♦ Click “Search” 

♦ Enter EIN 00008525 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Verify that the system records the EIN’s from values and to values 
mentioned above. 

♦ Close the ILM-Transaction Log. 

 

 

 

 

 

♦ The system logged the transaction performed in step # 
2310 into the ILM-Transaction log and the system 
displays the EIN 00008525 record. 

♦ The “From” and “To” values are displayed in the 
record. 

♦ The ILM Transaction Log  form is removed. 

P 

2335 Display the EIN Structure form to inspect the range of dates an inventory 
item is associated with a parent item. 

♦ Navigate to the ILM-EIN Structure form, click Search button on the 
Open window 

♦ Enter 00008525 into the Component EIN field 

 

 

 

♦ The ILM-EIN Structure Form is displayed 

♦ EIN 00008525’s record is displayed. 

P 
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♦ Select the Search button 

♦ Verify that the system records the EIN’s Active Date values and 
Inactive Date values. 

 

♦ Close ILM-EIN Structure form 

♦ The active and inactive dates are shown for EIN 
00008525 while on EIN 00000127 (original parent 
EIN). The active date is shown for EIN 00008525 on 
EIN 00020299 (new Parent EIN).. 

 80d. In a single transaction, an operator may update the inventory to 
reflect that an item and its associated components have been archived at 
a location. 

  

2400 While the ILM-EIN form is displayed, perform the following functions: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter 00001338 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Note the ECS Name _______________ 

and Location ___________ 

values for the EIN and its components 

♦ Click on the “EIN Transaction” button on the bottom of the form 

 

 

 

 

 

 

 

The system displays the ILM-EIN Transaction form. 

P 

2410 Enter the following information into the ILM-EIN Transaction form to 
archive Parent EIN 00001338 and all of its components to a new location: 

• Parent EIN: 00001338<TAB> 

• Effective Date: <current date><TAB> 

• Select Transaction Type: Archive<TAB> 

• Archive(P)arent-(C)omponent: P<TAB> 

• Archive Type: Return to Vendor<TAB> 

 

 

♦ When the Parent EIN is entered, the system populates 
the ECS Name, System Serial No, Part No, MFR, 
Description, Location, building, and room. 

♦ When “Archive” is selected from the Transaction 
Type, the system makes the archive page visible. 

♦ A prompt appears asking if you would like to perform 

P 
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• Click on the “Execute Transaction” button 

• Click the Exit EIN Transaction button. 

another transaction. 

♦ “Perform Another Transaction” prompt window is 
removed. 

♦  

2420 Navigate to ILM-EIN form to confirm that EIN 00001338 and its 
components were updated. 

♦ Click on Window on the menu bar 

♦ Select ILM-EIN form 

♦ Perform a search for that EIN 00001338. 

♦ Verify that EIN 00001338 and its components are updated 

♦ Select Components tab and inspect (Component) column. 

 

 

 

 

♦ The system displays EIN 00001338’s record. 

♦ These fields have the following values: 

♦ ECS Name = ARCHIVE 

♦ Location = EDFARC 

♦ Item Status = X 

♦ Audit Date = <current date> 

♦ Installation Date = BLANK 

♦ Exp = Y 

The Components Tab shows that all components have 
been archived as well. 

 

P 

2430 Navigate to the ILM-Transaction log to confirm that the system logs the 
archive transaction performed above (step 2410) for EIN 00001338 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-Transaction Log 

 

 

 

 

P 
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♦ Click “Search” 

♦ Enter 00001338 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Verify that the system records the EIN’s from values and to values 
mentioned above. 

♦ Close the ILM-Transaction Log form. 

♦ The system displays EIN 00001338’s record. 

♦ The “From” and “To” values are displayed in the 
record. 

 

♦ The ILM-Transaction Log form is removed. 

 80e.  In a single transaction, an operator may update the inventory to 
reflect that an item and its associated components have been shipped to 
a located. 

  

2500 While the ILM-EIN form is displayed, perform the following functions: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter 00001838 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Note the ECS Name ___________ 

 and Location _______________ 

values for the EIN and its components 

♦ Click on the “EIN Transaction” button on the bottom of the form 

 

 

 

 

 

 

 

The system displays the ILM-EIN Transaction form. 

P 

2510 Enter the following information into the ILM-EIN Transaction form to ship 
Parent EIN 00001838 and all of its components to a new location: 

• Parent EIN: 00001838<TAB> 

• Effective Date: <current date><TAB> 

• Select “Shipment” from the Transaction Type field<TAB> 

• Ship(P)arent-(C)omponent: P<TAB> 

 

 

♦ When the Parent EIN is entered, the system populates 
the ECS Name, System Serial No, Part No, MFR, 
Description, Location, building, and room. 

♦ When the “Shipment” is selected from the 
Transaction Type, the system makes the 

P 
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• New ECS Name: l0dus02<TAB> 

• New Location: LARC<TAB> 

• New Room: 2303<TAB> 

• Click on the “Execute Transaction” button 

• Click the Exit EIN Transaction button. 

Install/Move/Ship/RTS page visible. 

 

 

♦ A prompt appears asking if you would like to perform 
another transaction. 

♦ “Perform Another Transaction” prompt window is 
removed. 

2520 Navigate to ILM-EIN form to confirm that EIN 00001838 and its 
components were updated. 

♦ Click on Window on the menu bar 

♦ Select ILM-EIN form 

♦ If EIN 00001838 already displayed, click on View/Refresh Search. 

♦ Verify that EIN 00001838 and its components are updated to the values 
listed from step 2510 

 

 

 

♦ Click on components tabs and inspect Location column 

♦ Close the ILM-EIN form. 

♦ EIN 00001838’s record is displayed. 

♦ These fields have the following values: 

♦ ECS Name = l0dus02 

♦ Location = LARC 

♦ Building = 1268C 

♦ Room = 2303 

♦ Item Status = I 

♦ Audit Date = <current date> 

♦ Installation Date = <current date> 

♦ Exp = Y 

The Components Tab shows that all components have 
been shipped to the new location, as well. 

♦ The ILM-EIN form is closed. 

P 

2530 Navigate to the ILM-Transaction log to confirm that the system logs the 
installation transaction performed above for EIN 00001838 

♦ Click on the “Open” icon on the tool bar 

 

 

 

P 
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♦ Select ILM-Transaction Log 

♦ Click “Search” 

♦ Enter 00001838 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Verify that the system records the EIN’s from values and to values 
mentioned above. 

♦ Close the ILM-Transaction Log form. 

 

 

♦ The system displays EIN 00001838’s  record. 

 

 

♦ The “From” and “To” values are displayed in the 
record. 

♦ The ILM-Transaction Log form is closed. 

 

 NCR – ECSed39130 – Remedy ILM Intersite Data Exchange does not cover 
HW Relocation. 

  

2540 Navigate to the ILM-EIN Transaction form.  Enter the following 
information into the ILM-EIN Transaction form to ship Parent EIN 
00001654 and all of its components to a new location: 

• Parent EIN: 00001654<TAB> 

• Effective Date: <current date><TAB> 

• Select “Shipment” from the Transaction Type field<TAB> 

• Ship(P)arent-(C)omponent: P<TAB> 

• New ECS Name: g0new01<TAB> 

• New Location: GSFC<TAB> 

• New Building: 32<TAB> 

• New Room: C101<TAB> 

• Click on the “Execute Transaction” button 

 

 

♦ When the Parent EIN is entered, the system populates 
the ECS Name, System Serial No, Part No, MFR, 
Description, Location, building, and room. 

♦ When the “Shipment” is selected from the 
Transaction Type, the system makes the 
Install/Move/Ship/RTS page visible. 

 

 

♦ A prompt appears asking if you would like to perform 
another transaction. 

♦ “Perform Another Transaction” prompt window is 
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• Click the Exit EIN Transaction button. removed. 

Section 4: ILM Maintenance Management 

 70a.  Add a new MWO for a hardware item.   

2600 Log in as the “ilmmaint” user and navigate to the ILM-MWO to create a 
work order for Parent EIN 00001881. 

♦ Tools/Login.  Type in “ilmmaint” and click on OK button 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-MWO form 

♦ Click on “New” 

 

 

 

 

 

The system displays the ILM-MWO form. 

P 

2610 Enter the following information for the work order: 

♦ Parent EIN: 00001881<TAB> 

♦ Notification Date-Time: 10/30/03 10:00<TAB> 

♦ Failure Date-Time: 10/30/03 09:30<TAB> 

♦ Vendor Call Date-Time: 10/30/03 10:10<TAB> 

♦ Vendor Initial Resp Date-Time: 10/30/03 10:30<TAB> 

♦ Brief Description: Failed monitor, replaced by vendor at EDF <TAB> 

♦ Vendor Reference: 1234567<TAB> 

♦ Vendor Contact Name: Nelson Edf <TAB> 

♦ Click on the “Save” icon on the tool bar 

♦ Note the Work Order number______________ that the system 
generated and displayed in the Work Order No field.  You will need this 
number to search for the MWO just created. 

 

♦ When the Parent EIN is entered, the following fields 
will be populated, ECS Name, System serial No, Part 
No, MFR, Description, Location, Building, and 
Room. 

♦ When the user saves the changes, the system 
generates the next prefixed “EDF” Work Order No. 

♦ The system will briefly display the generated “EDF” 
Work order No on the status bar on the bottom left of 
the form. 

♦ The system sets the Exp field to “Y”. 

♦ When the “Add Failed/Replacement component 
button is pressed, the system displays the ILM-MWO 
Line Item form.  The system also populates the ILM-
MWO Line Item Work Order No, Parent EIN, ECS 
Name, Location, and MWO Status to that of the 

P 
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♦ Click on the “Add Fail-Replacement Component button. displayed MWO. 

 

 70c.  Enter information about the hardware components 
that were repaired/replaced for an MWO. 

♦   

2700 Enter the following information into the ILM-MWO Line Item form: 

♦ Component EIN:  00003886<TAB> 

♦ Event Type: F<TAB> 

♦ Maint Code: V<TAB> 

♦ Change Date: 10/30/03<TAB> 

♦ Replacement’s EIN: 00020301<TAB> 

♦ Press the “Add Another LI to MWO” button 

 

♦ When the Component EIN is entered, the following 
fields on the “Database Values” section of the form 
are populated:  Part No, Description, MFR, Mod-Ver, 
Serial No, PO Number, Vendor ID, Item Status, and 
GFE Num (optional). 

♦ When the “Add Another LI to MWO” button is 
pressed, the system saves the displayed line item 
record and populates a new ILM-MWO Line Item 
record with the Work Order No, Parent EIN, ECS 
Name, Location, and MWO Status of the displayed 
MWO. 

P 

2710 Enter the following information into the ILM-MWO Line Item form to add 
another line item to the MWO: 

♦ Component EIN: 00020301<TAB> 

♦ Click OK on the Remedy User—Note window. 

♦ Enter the following information into the Observed Values section: 

Part No: 365-1399-01<TAB> 

Serial No: 4651234561<TAB> 

Event Type: N<TAB> 

Maint Code: V<TAB> 

♦ Press the “Save” icon on the tool bar. 

♦ When the Component EIN is entered, the system 
displays a message stating that the EIN does not exist 
in the database and asks the user to enter the 
Component EIN’s information into the “Observed 
Values” section of the form. 

♦ When the Part No is entered, the following fields will 
be populated, MFR, Description, Hw-Sw Code, and 
Mod-Ver (Mod-Ver may or may not have a value.). 

♦ Line item entry is saved and the line item form is 
cleared. 

♦ ILM _MWO Line Item form is closed. 

P 
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♦ Close the ILM-MWO Line Item form. 

 80f.  An operator may invoke a transaction that updates inventory 
information based on an MWO. 

  

 60c. The operator may update the MWO status.  To be performed at 
the EDF.  (Note:  see step 3810 for a simulated DAAC). 

 

60b.  The operator may update the MWO, identifying at a minimum the 
action taken, date of maintenance event, and hardware item on which 
the maintenance action was taken.  To be performed at the EDF.  (Note:  
for simulated DAAC see step 3810) 

 

70b.  Update a MWO. 

  

2800 Before processing the work order line items just created, navigate to the 
ILM-EIN form to see the before data: 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-EIN form 

♦ Click “Search” 

♦ Enter 00003886 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ View the before process data 

♦ Parent EIN: 00001881 

♦ ECS Name: ILMSERV 

♦ Location: EDF 

♦ Building: 1616 

 

 

 

 

 

 

 

EIN 00003886 record is displayed. 

P 
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♦ Room: 2101B 

♦ Item Status: I 

♦ PO Number: CCW0009605 

♦ Vendor ID: SUN 

♦ Cost: 0 

♦ Installation Date: <supplied date> 

2810 Before processing the work order line items just created, check the ILM-
EIN form to see that the newly added line item does not currently exist in 
the ILM-EIN form. 

♦ Click the Open icon 

♦ Select ILM-EIN form and “Search” button 

♦ Enter 00020301 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Close the ILM-EIN form. 

 

 

♦ A message is displayed stating that there is no match. 

 

 

♦ The ILM-EIN form is closed. 

 

P 

2820 Login as “ilmpropty” and navigate to the ILM-MWO form, to process the 
two line items just added to the work order: 

♦ Tools/Login..type in “ilmpropty” and click on OK button 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-MWO form 

♦ Click “Search” 

♦ Enter the MWO number from step # 2610 in the Work Order No field 

♦ Click “Search”. 
Enter the following data: 

 

 

 

 

♦ The ILM-MWO form is displayed. 

 

♦ The ILM-MWO displays the work order created for 
Parent EIN 00001881  

♦ Remedy User Note indicating that “All Line Items are 

P 
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♦ Vendor Arrive Date-Time: 10/30/03 12:00 <TAB> 

♦ Vendor Complete Date-Time: 10/30/0312:30<TAB> 

♦ Click on the “Save” icon on the tool bar 

♦ Click on the “Process MWO Line Item” button on the bottom of the 
form to process the two line items created. 

♦ Click the “OK” button on the Note window. 

♦ Close the ILM-MWO form 

processed,” is displayed. 

♦ The system updated the MWO status to “R” for retire. 

♦ ILM-MWO form is closed. 

2830 

 

Navigate to the ILM-EIN form to verify the two processed line items 
records: 

♦ Click on “Window” on the menu bar or select the “Open” icon. 

♦ Select ILM-EIN form 

♦ Click “Search” 

♦ Enter 00003886 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

 

 

 

 

 

EIN 00003886’s record is displayed and fields’ values are 
as indicated below: 

♦ Parent EIN: <BLANK> 

♦ ECS Name: ARCHIVE 

♦ Location: EDFARC 

♦ Building: <BLANK> 

♦ Room: <BLANK> 

♦ Item Status: X 

♦ PO Number: CCW0009605 

♦ Vendor ID: SUN 

P 
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♦ Cost: 0 

♦ Installation Date: <BLANK> 

2835 Navigate to the ILM-EIN Structure form to verify that EIN 00003886 has 
been inactivated under Parent EIN 00001881. 

♦ Click the Open icon 

♦ Select ILM-EIN Structure form and click the Search button. 

♦ Enter 00003886 in the Component EIN field and click Search. 

♦ Inspect Components “Inactive Date” column 

♦ Close the ILM-EIN Structure form. 

 

 

♦ The ILM-EIN Structure form is opened in search 
mode. 

♦ EIN 00003886’s record is displayed and the Inactive 
Date field has a value displayed. 

♦ The ILM-EIN Structure form is closed. 

P 

2840 Search for and display the newly created EIN 00020301’s record. 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter 00020301 into the EIN field 

♦ Click on the “Search” icon on the tool bar 

♦ Close the ILM-EIN form. 

 

Specified record is displayed and fields’ values are as 
indicated below: 

♦ Parent EIN: 00001881 

♦ ECS Name: ILMSERV 

♦ Location: EDF 

♦ Building: 1616 

♦ Room: 2101B 

♦ Item Status:  

♦ PO Number: CCW0009605 

♦ Vendor ID: SUN 

♦ Cost: 0 

♦ Receive Date: 10/30/03 

♦ Installation Date: 10/30/03 

♦ Audit Date: 10/30/03 

P 
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The ILM-EIN form is closed. 

2850 Navigate to the ILM-Transaction Log to verify that the system logs the 
processing of the line items above. 

o Click on the “Open” icon on the tool bar 

o Select ILM-Transaction Log 

o Click on “Search” 

o Enter 00003886 into the EIN field 

o Click on “Search” 

o Verify the From values and To values 

 

 

 

 

 

Transaction log’s records are displayed. 

 

The “From” and “To” values are displayed. 

P 

2860 Use the ILM-Transaction Log to verify that the system logs the processing 
of the second of two line item above. 

o Click on the “Open” icon on the tool bar 

o Select ILM-Transaction Log 

o Click on “Search” 

o Enter 00020301 into the EIN field 

o Click on “Search” 

o Verify the From values and To values 

o Close the Transaction Log form 

 

 

 

Transaction log’s records are displayed. 

 

The “From” and “To” values are displayed. 

 

The form is removed. 

P 

 70e.  Delete a MWO. 

NCR – ECSed39128 – Remedy ILM Data Records’ deletion activity 

  

2910 Click the “Open” icon, select “ILM-MWO” and search button. 

o Enter MWOTODEL into the Work Order No field 

o Click on “Search” 

A message displayed “Deleting the MWO will also delete 
any related MWO line items.  Are you sure you want to 
delete this MWO?” 

ILM-MWO Line Item with work order no 

P 
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o Enter a “Y” into the Delete Entry field 

o Click on the “Save” icon on the tool bar. 

o Click on the Yes button when the message comes up. 

“MWOTELDEL” was also mark to be deleted. 

 

 60d.  An operator at a EDF ILM system may run predefined site and 
system-wide MWO reports for printout or display. 

 

70d.  Run one of each type of report applicable to the Maintenance 
Management Service. 

  

3000 Perform the following actions to run MWO reports: 

♦ Click the “Open” icon, select “ILM-MWO” and search button. 

♦ Enter 00001881 into the Parent EIN field and click the Search icon. 

♦ Select the Work Order created in step # 2610. 

♦ Click on Reports 

♦ Select “Work Order Verification’ Report 

♦ Select Print icon and OK button 

♦ Close the ILM-MWO form and report. 

 

 

 

 
 
 
The system displays the report on the screen. 
Report is printed 

The ILM-MWO form and report windows are closed. 

 

P 
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3005 Perform the following actions to run maintenance contract report: 

♦ Click File->Open 

♦ Select ILM-Maint Contract Form 

♦ Click the Search button on the Open window 

♦ Enter Contract ID CCJ13335 into the Contract ID field 

♦ Click on the ILM Report menu 

♦ Select the Maintenance Contract Report 

♦ Close the ILM-Maint Contract form. 

 

 

 

 

 

o The system displays the report on the screen. 

o The ILM-Maint Contract is closed. 

 

P 
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Section 5: ILM Data Export/Import + selected Sect. 1-4 criteria to be repeated at simulated DAAC 
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EDF DATA EXPORT 

3135 ♦ At the EDF, update the 
/usr/ecs/OPS/COTS/remedy/ilm_scripts/ilmconfig file on the 
EDF Remedy server as follows:Log in to EDF Unix workstation 
as “<Remedy_Admin>” and type password. 

♦ vi /usr/ecs/OPS/COTS/remedy/ilm_scripts/ilmconfig 

♦ ARSITE=EDF 

♦ ARSERVER=<EDF server> 

♦ REMEDY_ADMIN=<Remedy_Admin> 

♦ ARHOME=/home/<Remedy_Admin>/arHome 

♦ %:wq 

 

 

 

 

 

 

 

 

 

The ilmconfig file is edited and saved. 

P 

3140 At the EDF Remedy server, run the 
/usr/ecs/OPS/COTS/remedy/ilm_scripts/ilm_export script to export ILM 
data.  Type the following: 

♦ cd /usr/ecs/OPS/COTS/remedy/ilm_scripts 

♦  ./ilm_export 

♦ Executed commands are scrolled in the Unix window. 

♦ After the script is ran, the system will generate and 
push the following tar files to the 
/usr/ecs/OPS/COTS/remedy/ilm_scripts/import 
directory on the simulated DAAC Remedy hosts: 

♦ Date/time.EDF.forEDC 

♦ Date/time.EDF.forLARC 

♦ Date/time.EDF.forGSFC 

♦ Date/time.EDF.forNSIDC 

P 

3145 Transfer Date/time.EDF.forGSFC.tar file to the simulated DAAC1 import ♦ Date/time.EDF.forGSFC is the import directory. P 
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directory. 

SIMULATED DAAC 1 (GSFC)  

 10d.  Demonstrate that the DAAC ILM systems can import ILM data 
exported by the EDF ILM system. 

 

30a. An operator may view a display of a catalog of resources (e.g., 
hardware items, software items, consumable items) and information 
about those resources.  Information available should be representative 
of the information available in existing (XRP-based) resource catalog 
reports and displays.  To be performed at a simulated DAAC. 

  

3150 Before the import utility is run, log into DAAC1 account to verify that 
GSFC does not have EIN 00020299 data in the ILM-EIN form’s database. 
Perform the following steps to verify that GSFC is not able to see EIN 
00020299 and their components: 

o Start Remedy by selecting Start/Programs/Action Request 
System/Remedy User 

o Click on “Open”  

o Select ILM-EIN 

o Click on “Search” 

o Enter EIN 00020299 into the EIN field 

o Click on “search” icon on the tool bar 

o Click “OK” on the Remedy User-Warning window. 

 

 

 

 

 

 

 

 

 

♦ A message is displayed stating “No matching entries 
(or no permission to entries) for qualification 
criteria.” 

P 

3155 While the ILM-EIN form is displayed, 

o Click on “New Search” icon on the tool bar 

EIN 00001654 is displayed. 

 

P 
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o Enter EIN 00001654 into the EIN field 

o Click on “search” icon on the tool bar 

o Confirm that Location is at LARC 

3160 While the ILM-EIN form is displayed, 

o Click on “New Search” icon on the tool bar 

o Enter EIN EINTODEL into the EIN field 

o Click on “search” icon on the tool bar 

o Note the Delete Entry field is blank. 

o Close the ILM-EIN Form 

EIN EINTODEL is displayed. 

ILM-EIN form is closed. 

P 

3165 Navigate to the ILM-MWO form to verify that Work Order No 
MWOTODEL’s Delete Entry field is blank. 

o Click on “Open”  

o Select ILM-MWO 

o Click on “Search” 

o Enter EIN MWOTODEL into the Work Order No field 

o Click on “search” icon on the tool bar 

o Confirm that the Delete Entry is blank. 

Work order No MWOTODEL is display and the Delete 
Entry field is blank. 

P 

3170 Navigate to the ILM-License Entitlement form to verify that Entitlement ID 
LICENTODEL’s Delete Entry field is blank. 

o Click on “Open”  

o Select ILM-License Entitlement 

o Click on “Search” 

 

Entitlement ID LICENTODEL is display and the Delete 
Entry field is blank. 

P 
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o Enter LICENTODEL into the Entitlement ID field 

o Click on “search” icon on the tool bar 

o Confirm that the Delete Entry is blank. 

3185 Look at the PC registry to ensure that the appropriate user is selected. 

♦ Start->Run->regedit/OK 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Remedy\ARUser\Users 

Make sure the, “LastUserLoggedIn” is not a “-1”.  If so, change this value to 
a number associated with the USER#/ UserName that is being used in the 
command line. 

♦ CloseRegistry Editor window. 

 

 

 

 

Listing is displayed in Registry Editor window 

 

The correct user is registered. 

P 

3190 Using Notepad to update the daac_xfer.bat file 

 

♦ Start->Programs->Accessories->Notepad 

♦ Open c:\Program Files\remedy\Home\scripts\daac_xfer.bat (Select All 
Files if the icon is not displayed) 

♦ set ARSITE=GSFC 

♦ set REMEDY_ADMIN=<Remedy Admin> 

♦ set PASSWORD=<password> 

♦ set ARSERVER=p2ins02 

♦ Save the file: File/Save 

♦ Close Notepad  

 

 

 

 

 

 

 

 

daac_xfer.bat file is set to run as a simulated GSFC. 

P 

3195 On the simulated GSFC PC, use Window Explorer to add the 
pvc private key to Pageant

 
 

P 
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pvc_private_key to Pageant. 

 
♦ Open the C:\Program Files\(Show Files) \putty directory and 

double click on the ‘Pageant.exe’ file or Pageant icon. 
♦ Double click on the Pageant icon on the bottom right of the 

monitor to bring up pageant Key List Window. 
♦ Click “Add Key” 
♦ select “pvc_private_key.pri.PPK”  
♦ Click Open 
♦ Enter the passphrase. 
♦ Press the “Close” button to minimize pageant. 

 
 

♦ Pageant icon (computer wearing a hat) is 
displayed at the bottom right side of the monitor. 

♦ Pageant Key list window is displayed. 
 
 
♦ pvc_private_key is added to Pageant. 
♦ Pageant window is closd. 

 

3196 On the simulated GSFC ILM-PC, run the daac_xfer.bat file as follows: 

 

♦ On Window Explorer, navigate to c:\Program 
Files\Remedy\Home\Scripts 

♦ Double click on “daac_xfer” file 

 

 

 

 

 

After the batch file is ran, the batch file will get the 
*EDF.forGSFC file exported in step 3140 to the simulated 
GSFC ILM-PC and imports all the exported files. 

P 

 30c.  An operator may display a listing of consumable resources, non-
expendable resources, or both. To be performed at a simulated DAAC. 

 

30d.  The operator may display inventory information for each 
individual non-expendable resource defined in his system.  To be 
performed at the simulated DAAC. 

  

 10c.  Demonstrate that the EDF ILM system can export new and 
revised inventory, logistics, maintenance, and license data for 
forwarding to the simulated DAAC ILM systems. 
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3200 After the import utility is run, log into DAAC1 account to verify that GSFC 
does have EIN 00020299 data in the ILM-EIN form’s database. 
Perform the following steps to verify that GSFC is now able to see EIN 
00020299 and their components: 

o Start Remedy by selecting Start/Programs/Action Request 
System/Remedy User 

o Click on “Open”  

o Select ILM-EIN 

o Click on “Search” 

o Enter EIN 00020299 into the EIN field 

o Click on “search” icon on the tool bar 

EIN 00020299 is displayed. 

 

 

 

 

 

 

 

 

P 

3210 On ILM-EIN form: 

o Click on “New Search” icon on the tool bar 

o Enter EIN 00001654 into the EIN field 

o Click on “search” icon on the tool bar 

o Confirm that Location is now at GSFC 

EIN 00001654 is displayed with location equal to GSFC. P 

3215 On ILM-EIN form: 

o Click on “New Search” icon on the tool bar 

o Enter EIN EINTODEL into the EIN field 

o Click on “search” icon on the tool bar 

o Note the Delete Entry field equal to Y. 

o Close the ILM-EIN Form 

EIN EINTODEL is displayed with Delete Entry equal to 
Y. 

P 

3220 Navigate to the ILM-MWO form to verify that Work Order No 
MWOTODEL’s Delete Entry field is blank. 

Work Order No MWOTODEL is displayed with a Y in 
the Delete Entry field. 

P 
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o Click on “Open”  

o Select ILM-MWO 

o Click on “Search” 

o Enter EIN MWOTODEL into the Work Order No field 

o Click on “search” icon on the tool bar 

o Confirm that the Delete Entry equal to Y. 

3230 Navigate to the ILM-License Entitlement form to verify that Entitlement ID 
LICENTODEL’s Delete Entry field is blank. 

o Click on “Open”  

o Select ILM-License Entitlement 

o Click on “Search” 

o Enter LICENTODEL into the Entitlement ID field 

o Click on “search” icon on the tool bar 

o Confirm that the Delete Entry equal to Y. 

Entitlement ID LICENTODEL is displayed with a Y in 
the Delete Entry field. 

P 

3310 Log into the GSFC ILM-Remedy database and navigate to the ILM-EIN 
form, perform the following actions to view a listing of consumable  
resources: 

♦ Click on Start/Programs/Action Request System/Remedy User 

♦ Click on “Open”/ILM-EIN/Search 

♦ Select “Consumables” from the list of Hw-Sw Code 

♦ Click on the “Search” icon on the tool bar 

 

 

 

 

 

The system displays the consumable items in the database. 

P 

3320 Perform the following to view a listing of Hardware resources: 

♦ Click on the “New Search” icon on the tool bar 

 

 

P 



Remedy ILM Patch 1.0 Test Procedures Page 53 of 69  

♦ Select “Hardware” from the list of Hw-Sw Code 

♦ Click on the “Search” icon on the tool bar 

 

The system displays the hardware items in the database. 

3330 Perform the following to view a listing of Hardware and consumable 
resources: 

♦ Click on the “New Search” icon on the tool bar 

♦ Enter “[HC]” into the Hw-Sw Code 

♦ Click on the “Search” icon on the tool bar 

 

 

 

The system displays the hardware and consumable items 
in the database. 

P 

 10e.  Running reports available from one of the simulated DAAC ILM 
systems, verify that imported data is consistent with expectations and is 
specific to the DAAC. 

 

30k.  An operator at a simulated DAAC ILM system may run 
predefined site inventory reports for printout or display. 

  

3400 Perform the following actions to generate an inventory report for GSFC: 

♦ Click on “New Search” icon on the tool bar 

♦ Enter “GSFC” in the Location 

♦ Click on the “Search” icon on the tool bar 

♦ Press “Control” and click on the highlighted item on the result list to 
un-select the item. 

♦ Click on “ToolsÆReporting… 

♦ Select “Inventory Reports” from the list of reports 

♦ Click on ‘ReportÆExport to Æ File... 

♦ Select type ‘All files (*.*) 

♦ Save the report as “GSFC_Inventory_<date>” in c:\Program 

 

 

 

 

 

 

 

GSFC’s inventory report is generated. 

 

Report window is removed. 

P 
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Files\Remedy\Home\  

♦ Click OK in Remedy User window. 

♦ Close report window 

3420 View the report in Excel,  

♦ Double click on the MS Excel icon 

♦ Open the ‘GSFC_Inventory’ file in the C:\Program 
Files\Remedy\Home\ directory. 

♦ The “Text Import Wizard” appears, ensure that Delimited is selected as 
the file type in the “Original Data Type” section. 

♦ Press “Next” button on the bottom. Ensure that Tab is selected as the 
delimiter. Press “Next” button again. 

♦ Set the EIN and Parent EIN columns to Text. 

♦ Press the Finish button 

The GSFC’s Inventory report is displayed in Excel. P 

3430 Print the report from Excel: 

♦ In Excel window, select File/Print. 

♦ Select OK on the Print window 

♦ Close Excel. 

 

 

The report is printed. 

P 

 40a.  An operator at a simulated DAAC ILM system may view a display 
that lists the spare items in the site’s inventory and their descriptions.  
Information available should be representative of the information 
available in existing (XRP-based) spares inventory reports and displays. 

 

40g.  An operator at a simulated DAAC ILM system may run 
predefined site inventory spares reports for printout or display. 
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3500 Perform the following actions to generate a spare equipment report for 
GSFC: 

♦ Click on ILM Reports 

♦ Select “Spare Equipment Report” from the list of reports 

♦ Enter site “GSFC  

♦ Press the “Run Report” button 

♦ Click on the “Report Preview” to view the report layout. 

♦ Select Print icon and OK button on Print message. 

♦ Close the Report window. 

♦ Close the form. 

♦ A list of reports is displayed. 

♦ ILM-DIA-Reports window is displayed. 

♦ A Report Preview icon is displayed at the bottom of 
the screen. 

♦ The Spare Report is displayed. 

♦ GSFC’s spare report is generated. 

♦ The Spare Report is printed. 

♦ The Report Preview window is removed. 

 

♦ The ILM-EIN form is closed. 

 

P 

 70a.  Add a new MWO for a hardware item. 

 

  

3600 Navigate to the ILM-MWO to create a work order for Parent EIN 
00000357, 

♦ Click on the “Open” icon on the tool bar 

♦ Select ILM-MWO form 

♦ Click on “New” 

 

 

 

The system displays the New ILM-MWO form. 

P 

3610 Enter the following information for the work order: 

♦ Parent EIN: 00000357<TAB> 

♦ Notification Date-Time: 10/30/03 10:00<TAB> 

♦ Failure Date-Time: 10/30/03 09:30<TAB> 

♦ When the Parent EIN is entered, the following fields 
will be populated, ECS Name, System serial No, Part 
No, MFR, Description, Location, Building, and 
Room. 

♦ When the user saves the changes, the system 
generates the next prefixed “GSF” Work Order No. 

P 
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♦ Vendor Call Date-Time: 10/30/03 10:10<TAB> 

♦ Vendor Initial Resp Date-Time: 10/30/03 10:30<TAB> 

♦ Brief Description: Failed monitor, replaced by vendor/GFSC<TAB> 

♦ Vendor Reference: 1234568<TAB> 

♦ Vendor Contact Name: Nelson GFSC <TAB> 

♦ Click on the “Save” icon on the tool bar 

♦ Note the Work Order the system generated ___________________  
You will need this number to search for the MWO just created.                

♦ Click on the “Add Fail-Replacement Component” button.                          

♦ The system will display the generated “GSF” Work 
order No on the status bar on the bottom left of the 
form. 

♦ The system set the Exp field to “Y”. 

♦ When the “Add Fail-Replacement component button 
is pressed, the system displays the ILM-MWO Line 
Item form.  The system also populates the ILM-MWO 
Line Item Work Order No, Parent EIN, ECS Name, 
Location, and MWO Status to that of the displayed 
MWO. 

 

 70c.  Enter information about the hardware components that were 
repaired/replaced for an MWO. 

70b. Update a MWO. 

 

160.  On the simulated DAAC ILM system, attempt to create an MWO 
line item having Maintenance Code “R” and no value for New Parent 
EIN. 

  

3700 Enter the following information into the ILM-MWO Line Item form: 

♦ Component EIN:  00005190<TAB> 

♦ Event Type: F<TAB> 

♦ Maint Code: V<TAB> 

♦ Change Date: 10/30/03<TAB> 

♦ Replacement’s EIN: 00020400<TAB> 

♦ Press the “Add Another LI to MWO” button 

 

 

♦ When the Component EIN is entered, the following 
fields on the “Database Values” section of the form 
are populated: Part No, Description, MFR, Mod-Ver, 
Serial No, PO Number, Vendor ID, Item Status, and 
GFE Num. 

♦ When the “Add Another LI to MWO” button is 
pressed, the system will populate the ILM-MWO Line 

P 
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Item Work Order No, Parent EIN, ECS Name, 
Location, and MWO Status to that of the displayed 
MWO. 

3710 Enter the following information into the ILM-MWO Line Item form to add 
another line item to the MWO: 

♦ Component EIN: 00020400<TAB> 

♦ Part No: 365-1399-01<TAB> 

♦ Serial No: 46512354214<TAB> 

♦ Event Type: N<TAB> 

♦ Maint Code: V<TAB> 

♦ Press the “Add Another LI to MWO” button 

 

 

♦ When the Component EIN is entered, the system 
displays a message stating that the EIN does not exist 
in the database and asks the user to enter the 
Component EIN’s information into the “Observed 
Values” section of the form. 

♦ When the Part No is entered, the following fields will 
be populated, MFR, Description, Hw-Sw Code, and 
Mod-ver (if Mod-Ver value exists). 

P 

3720 Enter the following information into the ILM-MWO Line Item form: 

♦ Component EIN:  00005190<TAB> 

♦ Event Type: R<TAB> 

♦ Maint Code: R<TAB> 

♦ Click “OK” on the Warning message. 

♦ Change Date: 10/30/03<TAB> 

♦ Click on the “Save” icon on the tool bar 

♦ Press “OK” on the Error message and enter EIN 00020299 into the New 
Parent EIN field. 

♦ Click on the “Save” icon on the tool bar 

 

♦ Close the ILM-MWO Line Item form. 

 

 

♦ When the Component EIN is entered, the following 
fields on the “Database Values” section of the form 
are populated:  Part No, Description, MFR, Mod-Ver, 
Serial No, PO Number, Vendor ID, Item Status, and 
GFE Num (if available). 

♦ A Remedy User warning message is displayed, stating 
“You have selected Event Type "R" and Maint Code 
"R". So, you must also complete the New Parent EIN 
field (in the New and Relocation Items section) before 
saving this record. 

♦ A Remedy User Error message is displayed, stating 
“The Parent EIN field must be completed also when 
you select Event Type “R” and Maint Code “R”, 

P 
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♦ Record is saved. 

♦ The ILM-MWO Line Item form is closed. 

 60a.  An operator at a simulated DAAC may view displays of MWOs 
for the site.  Information available should be representative of the 
information available in existing (XRP-based) corrective maintenance 
reports and displays. 

 

60c.  The operator may update the MWO status.  To be performed at a 
simulated DAAC. 

 

60b.  The operator may update the MWO, identifying at a minimum the 
action taken, date of maintenance event, and hardware item on which 
the maintenance action was taken.  To be performed at a simulated 
DAAC. 

 

70b.  Update a MWO. 

  

3800 Navigate to the ILM-MWO form: 

♦ Click on “Window” on the menu bar 

♦ Select ILM-MWO 

♦ Click View -> Refresh Search. 

 

 

 

The Work Order generated above is displayed. 

P 

3810 Perform the following updates for the displayed MWO: 

♦ MWO Status: A<TAB> 

♦ Vendor Arrive Date-Time: 10/30/03 13:00<TAB> 

♦ Vendor Complete Date-Time: 10/30/03 13:30<TAB> 

 

 

 

 

P 



Remedy ILM Patch 1.0 Test Procedures Page 59 of 69  

♦ Click on the “Save” icon on the tool bar  

The changes are saved. 

 70e.  Delete an MWO.   

3900 Create another MWO for parent EIN 00020299: 

♦ Click on the “New Request” icon on the tool bar 

♦ Parent EIN: 00020299<TAB> 

♦ Click on the “Save” icon on the tool bar 

♦ Note the new prefixed “GSF” Work Order No 
_______________________.  You will need this to perform the search 
for the next step. 

♦ Enter a Y in the Delete Entry field. 

♦ Click on the “Save” icon on the tool bar. 

♦ Click “Yes” button on the Delete window. 

♦ When the Parent EIN is entered, the following fields 
will be populated, ECS Name, System serial No, Part 
No, MFR, Description, Location, Building, and 
Room. 

♦ Deletion message is displayed. 

♦ When the user saves the changes, the system 
generates the next prefixed “GSF” Work Order No. 

♦ The system will display the generated “GSF” Work 
order No  

♦ The system set the Exp field to “Y”. 

♦ Work order marked to be deleted. 

P 

 60e.  An operator at a simulated DAAC ILM system may run 
predefined site MWO reports for printout or display. 

 

70d.  Run one of each type of report applicable to the Maintenance 
Management Service. 

  

4000 Perform the following actions to run MWO reports: 

♦ Click on the New search icon 

♦ Enter GFSC into the Location field 

♦ Click on Reports 

♦ Select “Work Order Verification Report” 

 

 

 

♦ The system displays the report on the screen. 

♦ The ILM-MWO form is closed. 

P 
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♦ Close the ILM-MWO form.  

 10a.  Demonstrate that each of the simulated DAAC ILM systems can 
export new and updated records about hardware maintenance events 
forwarding to the EDF ILM system. 

  

5000 Initiate the Remedy Administrator Tool, enable and set the time criteria for 
the following Escalations: 

o Start -> Programs -> Action Request System -> Remedy 
Administrator 

o Click the server’s icon. 

o On the Remedy Server’s window click on Escalations 

o On the Escalations window double click escalation “ILM-EIN-
GSFC” 

o On the Basic tab click on Enable. 

o Click on the Time Criteria tab 

o Execution -> Time 

o Weekdays – select current day 

o Hour – select current hour and 10 minutes after the current time. 

o Click on the “Save” icon on the tool bar. 

Repeat this step for the following Escalations.  Leave a 5 minutes gap 
between each escalation. 

 ILM-EINST-GSFC 

 ILM-MLI-GSFC 

 ILM-MWO-GSFC 

 ILM-TRLOG-GSFC 

o Remedy Administrator is displayed. 

o A list of Escalations is displayed. 

o Modify Escalation (ILM-EIN-GSFC) is 
displayed. 

o There is a check mark in the Enable field. 

o The time is set. 

o ILM-EIN-GSFC – Will remove all the ILM-EIN 
records that do not have location equal to GSFC 
or EMOSG. 

o ILM-EINST-GSFC – Will remove all the ILM-
EIN Structure records that do not have location 
equal to GSFC or EMOSG. 

o ILM-MLI-GSFC – Will remove all the ILM-
MWO Line Item records that do not have Work 
Order No starting with GSF% or EMO%). 

o ILM-MWO-GSFC - Will remove all the ILM-
MWO records that do not have Work Order No 
starting with GSF% or EMO%). 

o ILM-TRLOG-GSFC - Will remove all the ILM-
Transaction Log records that do not have location 
equal to GSFC or EMOSG. 

P 
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5100 Set the time criteria for the following Escalations: 

o On the Remedy Server’s window click on Escalations 

o On the Escalations window double click escalation “ILM-AHT-
DEL” 

o On the Basic tab click on Enable. 

o Click on the Time Criteria tab 

o Execution -> Time 

o Weekdays – select current day 

o Hour – select current hour and 10 minutes after the current time. 

o Click on the “Save” icon on the tool bar. 

Repeat this step for the following Escalations.  Leave a 2 minutes gap 
between each escalation. 

• ILM-EIN-DEL 

• ILM-EINST-DEL 

• ILM-HWS-DEL 

• ILM-IVL-DEL 

• ILM-LIC-DEL 

• ILM-LICENT-DEL 

• ILM-LICMAP-DEL 

• ILM-LICPRO-DEL 

• ILM-MC-DEL 

• ILMMLI-DEL 

o A list of Escalations is displayed. 

o Modify Escalation (ILM-AHT-DEL) is 
displayed. 

o The time is set. 

o ILM-AHT-DEL – Will remove any ILM-
Additional Host records having a Y in the Delete 
Entry field. 

o ILM-AHT-DEL – Will remove any ILM-
Additional Host records having a Y in the Delete 
Entry field. 

o ILM-EIN-DEL – Will remove any ILM-EIN 
records having a Y in the Delete Entry field. 

o ILM-EINST-DEL – Will remove any ILM-EIN 
Structure records having a Y in the Delete Entry 
field. 

o ILM-HWS-DEL – Will remove any ILM-Hw-Sw 
Code records having a Y in the Delete Entry 
field. 

o ILM-IVL-DEL – Will remove any ILM-
Inventory Location records having a Y in the 
Delete Entry field. 

o ILM-LIC-DEL – Will remove any ILM-License 
records having a Y in the Delete Entry field. 

o ILM-LICENT-DEL – Will remove any ILM-
License Entitlement records having a Y in the 
Delete Entry field. 

o ILM-LICMAP-DEL – Will remove any ILM-

P 
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• ILM-MWO-DEL 

• ILM-OEM-DEL 

• ILM-SIT-DEL 

• ILM-STA-DEL 

• ILM-TRLOG-DEL 

License Mapping records having a Y in the 
Delete Entry field. 

o ILM-LICPRO-DEL – Will remove any ILM-
License Products records having a Y in the 
Delete Entry field. 

o ILM-MC-DEL – Will remove any ILM-Maint 
Contract records having a Y in the Delete Entry 
field. 

o ILM-MLI-DEL – Will remove any ILM-MWO 
Line Item records having a Y in the Delete Entry 
field. 

o ILM-MWO-DEL – Will remove any ILM-MWO 
records having a Y in the Delete Entry field. 

o ILM-OEM-DEL – Will remove any ILM-OEM 
Parts records having a Y in the Delete Entry field. 

o ILM-SIT-DEL – Will remove any ILM-Site 
records having a Y in the Delete Entry field. 

o ILM-STA-DEL – Will remove any ILM-Status 
Code records having a Y in the Delete Entry 
field. 

o ILM-TRLOG-DEL – Will remove any ILM-
Transaction Log records having a Y in the Delete 
Entry field. 

 After all the Escalations ran, perform the following checks to ensure that 
GSFC’s database only contains GSFC’s records. 

  

5110 On Remedy User, navigate to the ILM-EIN form 

o Click on the “Open” icon on the tool bar 

o The system displays all the GSFC’s and 
EMOSG’s EIN records in the database. 

P 
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o Select “ILM-EIN” 

o Click the “Search” button  

o Click on “search” icon on the tool bar 

o Note that all the records’ location is either GSFC or EMOSG. 

5120 Navigate to the ILM-MWO form to confirm that only Work Order No with 
prefix GSF or EMO in the database 

o Click on the “Open” icon on the tool bar 

o Select “ILM-MWO” 

o Click the “Search” button  

o Click on “search” icon on the tool bar 

o Note that all the Work Order No is prefixed with GSF or EMO. 

o The system displays all MWOs with prefix GSF 
or EMO. 

P 

 After all the Escalations ran, perform the following checks to ensure that all 
records having a Y in the Delete Entry field are deleted. 

 P 

5130 On the ILM-EIN form, 

o Click on “New Search” icon on the tool bar 

o Enter EIN EINTODEL into the EIN field 

o Click on “search” icon on the tool bar 

o Click OK on warning Window 

o Close the ILM-EIN Form 

A message displayed “No matching entries (or no 
permission to entries) for qualification criteria (ARWARN 
1200)” 

P 

5140 Navigate to the ILM-MWO form to verify that Work Order No 
MWOTODEL’s Delete Entry field is blank. 

o Click on “Open”  

o Select ILM-MWO 

o A message displayed “No matching entries (or no 
permission to entries) for qualification criteria 
(ARWARN 1200)” 

P 
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o Click on “Search” 

o Enter MWOTODEL into the Work Order No field 

o Click on “search” icon on the tool bar 

o Click OK on warning Window 

o Close the ILM-MWO form. 

5150 Navigate to the ILM-License Entitlement form to verify that Entitlement ID 
LICENTODEL’s Delete Entry field is blank. 

o Click on “Open”  

o Select ILM-License Entitlement 

o Click on “Search” 

o Enter LICENTODEL into the Entitlement ID field 

o Click OK on warning Window 

o Close the ILM-License Entitlement form. 

o A message displayed “No matching entries (or no 
permission to entries) for qualification criteria 
(ARWARN 1200)” 

P 

5160 Update the /usr/ecs/OPS/COTS/remedy/ilm_scripts/ilmconfig file on the 
DAAC 1 (GSFC)  ILM server as follows: 

♦ vi /usr/ecs/OPS/COTS/remedy/ilm_scripts/ilmconfig 

♦ ARSITE=GSFC 

♦ ARSERVER=p2ins02 

♦ REMEDY_ADMIN=<Remedy admin> 

♦ PASSWORD=<password> 

♦ ARHOME=/home/<Remedy_Admin>/arHome 

:wq 

 

 

 

 

 

 

 

♦ The ilmconfig file is edited and saved. 

P 
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5170 Run the /usr/ecs/OPS/COTS/remedy/ilm_scripts/ilm_export script to export 
ILM data.  Type the following: 

♦ cd /usr/ecs/OPS/COTS/remedy/ilm_scripts 

♦  ./ilm_export 

♦ After the script is ran, the system will generate the 
following tar files in the 
/usr/ecs/OPS/COTS/remedy/ilm_scripts/export 
directory: 

♦ Date/time.GSFC.forEDF.tar 

P 

5180 Transfer the Date/time.GSFC.forEDF.tar to the simulated EDF server’s 
import directory. 

♦ Date/time.GSFC.forEDF.tar is in the simulated EDF 
server’s import directory. 

P 
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EDF DATA IMPORT  

 10b.  Demonstrate that the EDF ILM system can receive and 
consolidate the ILM data received from the other simulated DAAC 
ILM systems. 

 

10f.  Verify that maintenance data imported from each of the simulated 
DAAC ILM system is available in the EDF system. 

  

5200 At EDF, before the export utility is run, log into the EDF simulated ILM-
Remedy to verify that the work order created above for Parent EIN 
00000357 is not yet in the database. 

o Click on “Open”  

o Select ILM-MWO 

o Click on “Search” 

o Enter the prefixed “GSF” Work order No for Parent EIN 00000357 
from Step 3610 into the Work Order No field 

o Click on “search” icon on the tool bar 

o Click OK on the warning window 

 

 

 

 

 

 

 

A message is displayed stating “No matching entries (or 
no permission to entries) for qualification criteria. 

P 

5210 At the EDF, Look at the PC registry to ensure that the appropriate user is 
selected. 

♦ Start->Run->regedit 

♦ Select file 
HKEY_LOCAL_MACHINE\SOFTWARE\Remedy\ARUser\Users 

♦ Make sure the, “LastUserLoggedIn” is not a “-1”.  If so, change 

The correct user is registered. P 
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this value to a number associated with the USER#/ UserName that 
is being used in the command line. 

♦ Close window. 

5220 At the EDF, Use Notepad to update the edf_xfer.bat file 

 

♦ Start->Programs->Accessories->Notepad 

♦ Open c:\program files\remedy\home\scripts\edf_xfer icon (Select “All 
Files” if needed)  

♦ set REMEDY_ADMIN=<Remedy_Admin> 

♦ set PASSWORD=<password> 

♦ set ARSERVER=f3mss01 

♦ Save the file 

♦ Close Notepad 

 

 

 

 

 

 

 

 

The edf_xfer.bat file is set to run at the simulated EDF. 

P 

5230 On the simulated EDF PC, use Window Explorer to add the 
F_Lab_private_key to Pageant. 

 

♦ Open the C:\Program Files\Putty directory and double click on 
the ‘Pageant’ Icon. 

♦ Double click on the blue icon (pageant) on the bottom right of the 
monitor to bring up pageant. 

♦ Click “Add Key” 
♦ select “F_Lab_Private.PKK key”  
♦ Click ‘Open’ 
♦ Enter the passphrase and click on OK. 
♦ Press the “Close” button to minimize pageant. 

F_Lab_private_key is added to Pageant. P 

5240 At  the simulated EDF ILM-PC, run the edf_xfer.bat file as follow: ♦ An exe window will open, display the commands as P 
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♦ On Window Explorer, navigate to c:\Program 
Files\Remedy\Home\Scripts 

♦ Double-click on “edf_xfer.bat” icon 

♦ Close scripts window 

executed, and close when completed. 

♦ The contents of the *forEDF.tar files exported by the 
simulated DAACs 1 and 2  is imported into the EDF’s 
Remedy database.. The importation will be verified in 
steps 4290 and 4295. 

5250 At the EDF, navigate to the ILM-MWO form and search for the work 
order for Parent EIN 00000357 from DAAC 1 generated above: 

o Click on “Open”  

o Select ILM-MWO 

o Click on “Search” 

o Enter the prefixed “GSF” Work order No for Parent EIN 
00000357 from Step 3610 into the Work Order No field 

o Click on “Search” icon on the tool bar 

o View the Failed & Replacement Components listing on the 
bottom of the form.  There should be three line items 
(00005190 and 00020400) 

o Close the form. 

The work order is displayed. P 

 Test End   
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